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Building Web Apps with R Shiny
Overview
Shiny lets you make web applications that do anything you can code in R. For example, you can share your data analysis in a dynamic way with people who don’t use R, collect and visualize data, or even make DATA ART.
While there is a wealth of material available on the internet to help you get started with Shiny, it can be difficult to see how everything fits together. This class will take a predominantly live coding approach, rather than a lecture-only approach, so you can code along with the instructor and deal with the inevitable bugs and roadblocks together.
This class will teach you the basics of Shiny app programming, giving you skills that will form the basis of almost any app you want to build. By the end of the class, you will have created a custom app that collects and saves data, allows users to dynamically visualize the data, and produces downloadable reports.
0.1 Installing shinyintro
To install the class package, which will provide you with a copy of all of the shiny apps we’ll use for demos and the basic template, paste the following code into the console in RStudio. See Appendix A for help installing R and RStudio.
# you may have to install devtools first with
# install.packages("devtools")
devtools::install_github("debruine/shinyintro")
The class package lets you access the book or run the demo apps offline.
shinyintro::book()
shinyintro::app("first_demo")
You can also clone the demo apps.
shinyintro::clone("basic_template", "myapps/newapp")
0.2 Example Apps
The following are some diverse examples of Shiny apps that the instructor has made.
0.2.1 Computing
To participate in the hands-on exercises, you are strongly encouraged to use a computer with the most recent version of R INSTALLED. Participants are also encouraged to download and install RSTUDIO, a front-end for R that makes it easier to work with. This software is free and available for Windows, Mac, and Linux platforms.
0.2.2 What experience do I need?
You need to have basic familiarity with R, including data import, data processing, visualization, and functions and control structures (e.g., if/else). Instruction will be done using RStudio. Some familiarity with ggplot2 and dplyr would be useful. You definitely do not need to be an expert coder, but the following code should not be challenging to understand.
library(ggplot2)
pets <- read.csv("pets.csv")
dv <- sample(c("score", "weight"), 1)
if (dv == "score") {
g <- ggplot(pets, aes(pet, score, fill = country))
} else if (dv == "weight") {
g <- ggplot(pets, aes(pet, weight, fill = country))
}
g + geom_violin(alpha = 0.5)
If you want to brush up on your R (especially tidyverse), and also gain familiarity with the instructor’s teaching style, the book APPLIED DATA SKILLS provides a good overview.
0.3 Further Resources
There are a lot of great resources online to reinforce or continue your learning about Shiny. I advise going back to learning materials periodically because things that don’t make sense the first (or second or third…) time around often click after you’ve had some experience.
1 Your First Shiny App
1.1 The Demo App
To start, let’s walk through the basics of setting up a shiny app, starting with the example built into RStudio. I won’t explain yet how shiny apps are structured; the goal is to just get something up and running, and give you some familiarity with the layout of a fairly simple app.
1.1.1 Set Up the Demo App
Figure 1.1: Creating a demo app.
Under the File menu, choose New Project.... You will see a popup window like the one above. Choose New Directory.
Choose Shiny Web Application as the project type.
I like to put all of my apps in the same directory, but it doesn’t matter where you save it.
Your RStudio interface should look like this now.
Figure 1.2: RStudio interface with the built-in demo app loaded.
If you are not using RStudio or your source code doesn’t look like this, replace it with the code below:
View Code
#
# This is a Shiny web application. You can run the application by clicking
# the 'Run App' button above.
#
# Find out more about building applications with Shiny here:
#
# http://shiny.rstudio.com/
#
library(shiny)
# Define UI for application that draws a histogram
ui <- fluidPage(
# Application title
titlePanel("Old Faithful Geyser Data"),
# Sidebar with a slider input for number of bins
sidebarLayout(
sidebarPanel(
sliderInput("bins",
"Number of bins:",
min = 1,
max = 50,
value = 30)
),
# Show a plot of the generated distribution
mainPanel(
plotOutput("distPlot")
)
)
)
# Define server logic required to draw a histogram
server <- function(input, output) {
output$distPlot <- renderPlot({
# generate bins based on input$bins from ui.R
x <- faithful[, 2]
bins <- seq(min(x), max(x), length.out = input$bins + 1)
# draw the histogram with the specified number of bins
hist(x, breaks = bins, col = 'darkgray', border = 'white')
})
}
# Run the application
shinyApp(ui = ui, server = server)
Click on Run App in the top right corner of the source pane. The app will open up in a new window. Play with the slider and watch the histogram change.
Figure 1.3: Demo application interface
You can also open up the app in a web browser by clicking on Open in Browser.
1.1.2 Modify the Demo App
Now we’re going to make a series of changes to the demo app until it’s all your own.
You can close the app by closing the window or browser tab it’s running in and clicking the red stop sign in the console tab, or leave it running while you edit the code. If you have multiple screens, it can be useful to have the app open on one screen and the code on another.
Find the application title. It is the first argument to the function titlePanel(). Change the title to "My First App". Make sure the title is inside quotes and the whole quoted string is inside the parentheses. Save the file (cmd-S or File > Save).
Figure 1.4: App with changed title.
Click Run App (or Reload App if you haven’t closed the app window) in the source pane. If you haven’t saved your changes, it will prompt you to do so. Check that the app title has changed.
Now let’s change the input. Find the function sliderInput() (line 21). The first argument is the name you can use in the code to find the value of this input, so don’t change it just yet. The second argument is the text that displays before the slider. Change this to something else and re-run the app.
sliderInput("bins",
"Number of bins:",
min = 0,
max = 50,
value = 30)
See if you can figure out what the next three arguments to sliderInput() do. Change them to different integers, then re-run the app to see what’s changed.
The arguments to the function sidebarPanel() are just a list of things you want to display in the sidebar. To add some explanatory text in a paragraph before sliderInput(), just use the paragraph function p().
sidebarPanel(
p("I am explaining this perfectly"),
sliderInput("bins",
"Choose the best bin number:",
min = 10,
max = 40,
value = 25)
)
Figure 1.5: Sidebar with an added paragraph.
The sidebar shows up on the left if your window is wide enough, but moves to the top of the screen if it’s too narrow.
I don’t like it there, so we can move this text out of the sidebar and to the top of the page, just under the title. Try this and re-run the app.
# Application title
titlePanel("My First App"),
p("I am explaining this perfectly"),
# Sidebar with a slider input for number of bins
sidebarLayout(...)
See where you can move the text in the layout of the page and where causes errors.
I’m also not keen on the grey plot. We can change the plot colour inside hist()
# draw the histogram with the specified number of bins
hist(x, breaks = bins, col = 'steelblue3', border = 'grey30')
There are a lot of ways to represent colour in R. The easiest three are:
The color "steelblue3" is pretty close to the shiny interface default colour, but feel free to choose whatever you like.
I prefer ggplots, so let’s make the plot with geom_histogram() instead of hist() (which is a great function for really quick plots, but not very visually appealing). Since we need several functions from the ggplot2 package, we’ll need to load that package at the top of the script, just under where the shiny package is loaded:
library(shiny)
library(ggplot2)
You can replace all of the code in renderPlot() with the code below.
output$distPlot <- renderPlot({
# create plot
ggplot(faithful, aes(waiting)) +
geom_histogram(bins = input$bins,
fill = "steelblue3",
colour = "grey30") +
xlab("What are we even plotting here?") +
theme_minimal()
})
You can set fill and colour to whatever colours you like, and change theme_minimal() to one of the other BUILT-IN GGPLOT THEMES.
What are we even plotting here? Type ?faithful into the console pane to see what the waiting column represents (faithful is a built-in demo dataset). Change the label on the x-axis to something more sensible.
1.1.3 Add New Things
The faithful dataset includes two columns: eruptions and waiting. We’ve been plotting the waiting variable, but what if you wanted to plot the eruptions variable instead?
Try plotting the eruption time (eruptions) instead of the waiting time. You just have to change one word in ggplot() and update the x-axis label.
We can add another input widget to let the user switch between plotting eruption time and wait time. We’ll learn more about the different input options in Section ??. We need to toggle between two options, so we can use either radio buttons or a select box. Radio buttons are probably best if you have only a few options and the user will want to see them all at the same time to decide.
Add the following code as the first argument to sidebarPanel(), which just takes a list of different widgets. radioButtons() is the widget we’re using. We’ll set four arguments:
For choices, the label is what gets shown to the user and the value is what gets used by the code (these can be the same, but you often want the user label to be more descriptive).
radioButtons(inputId = "display_var",
label = "Which variable to display",
choices = c("Waiting time to next eruption" = "waiting",
"Eruption time" = "eruptions"),
selected = "waiting"
),
Save this and re-run the app.
Figure 1.6: A radioButton widget above a sliderInput widget.
You should have a radio button interface now. You can click on the options to switch the button, but it won’t do anything to your plot yet. We need to edit the plot-generating code to make that happen.
First, we need to change the x-axis label depending on what we’re graphing. We use an if/else statement to set the variable xlabel to one thing if input$display_var is equivalent to "eruptions", and to something else if it’s equivalent to "waiting". Put this code at the very beginning of the code block for renderPlot() (after the line output$distPlot <- renderPlot({).
# set x-axis label depending on the value of display_var
if (input$display_var == "eruptions") {
xlabel <- "Eruption Time (in minutes)"
} else if (input$display_var == "waiting") {
xlabel <- "Waiting Time to Next Eruption (in minutes)"
}
The double-equal-signs == means “equivalent to and is how you check if two things are the same; if you only use one equal sign, you set the variable on the left to the value on the right.
Then we have to edit ggplot() to use the new label and to plot the correct column. The variable input$display_var gives you the user-input value of the widget called "display_var".
# create plot
ggplot(faithful, aes(.data[[input$display_var]])) +
geom_histogram(bins = input$bins,
fill = "steelblue3",
colour = "grey30") +
xlab(xlabel) +
theme_minimal()
::: {.warning data-latex=““} Notice that the code aes(waiting) from before has changed to aes(.data[[input$display_var]])</code>. Because `input$display_varis a <a class='glossary' target='_blank' title='A piece of text inside of quotes.' href='https://psyteachr.github.io/glossary/s#string'>string</a>, we have to select it from the.dataplaceholder (which refers to thefaithful` data table) using double brackets. :::]]) %>% summarise_if(is.numeric, input$stat, na.rm = TRUE) })
output$caption <- renderText({ sprintf("%ss by %s", toupper(input$stat), input$group) }) }
</div>
### reactive {-}
Use <code><span class='fu'>reactive</span>()</code> to update the output table and caption whenever group or stat change. Ignore the update button.
<div class='webex-solution'><button>Solution</button>
```r
server <- function(input, output, session) {
data <- reactive({
msleep %>%
group_by(.data[[input$group]]) %>%
summarise_if(is.numeric, input$stat, na.rm = TRUE)
})
output$table <- renderTable(data())
caption <- reactive({
sprintf("%ss by %s", toupper(input$stat), input$group)
})
output$caption <- renderText(caption())
}
observeEvent
Use observeEvent() to update the output table with the appropriate summary table and to update the caption with an appropriate caption only when the update button is clicked.
Solution
server <- function(input, output, session) {
observeEvent(input$update, {
data <- msleep %>%
group_by(.data[[input$group]]) %>%
summarise_if(is.numeric, input$stat, na.rm = TRUE)
output$table <- renderTable(data)
caption <-
sprintf("%ss by %s", toupper(input$stat), input$group)
output$caption <- renderText(caption)
})
}
reactiveVal
Use reactiveVal() to update the output table and caption only when the update button is clicked.
Solution
server <- function(input, output, session) {
data <- reactiveVal()
caption <- reactiveVal()
observeEvent(input$update, {
newdata <- msleep %>%
group_by(.data[[input$group]]) %>%
summarise_if(is.numeric, input$stat, na.rm = TRUE)
data(newdata)
# this is an alternative way to set reactiveVal
# by piping the value into the function
sprintf("%ss by %s", toupper(input$stat), input$group) %>%
caption()
})
output$table <- renderTable(data())
output$caption <- renderText(caption())
}
reactiveValues
Use reactiveValues() to update the output table and caption only when the update button is clicked.
Solution
server <- function(input, output, session) {
v <- reactiveValues()
observeEvent(input$update, {
v$data <- msleep %>%
group_by(.data[[input$group]]) %>%
summarise_if(is.numeric, input$stat, na.rm = TRUE)
v$caption <-
sprintf("%ss by %s", toupper(input$stat), input$group)
})
output$table <- renderTable(v$data)
output$caption <- renderText(v$caption)
}
eventReactive
Use eventReactive() to update the output table and caption only when the update button is clicked.
Solution
server <- function(input, output, session) {
data <- eventReactive(input$update, {
msleep %>%
group_by(.data[[input$group]]) %>%
summarise_if(is.numeric, input$stat, na.rm = TRUE)
})
output$table <- renderTable(data())
caption <- eventReactive(input$update, {
sprintf("%ss by %s", toupper(input$stat), input$group)
})
output$caption <- renderText(caption())
}
1.2 Your App
Add reactive functions to your custom app. Think about which patterns are best for your app. For example, if you need to update a data table when inputs change, and then use it in more than one output, it’s best to use reactive() to create a function for the data and callit in the render functions for each output, rather than creating the data table in each render function.
2 Reading and saving data
Figure 2.1: RadioTables Demo App. You can also access this app with shinyintro::app("radiotables")or view it in a separate tab with the SHOWCASE INTERFACE.
2.1 Local Data
You can read and write data from a Shiny app the same way you do from any R script. We will focus on reading data, since writing data locally can cause problems and is better done with Google Sheets.
The working directory for a Shiny app is the directory that app.R is in. I recommend keeping your data in a directory called data to keep things tidy.
# read local data
my_data <- readxl::read_xls("data/my_data.xls")
# read data on the web
countries <- readr::read_csv("https://datahub.io/core/country-list/r/data.csv")
languages <- jsonlite::read_json("https://datahub.io/core/language-codes/r/language-codes.json")
2.2 Google Sheets
One of the best ways to start collecting data with a Shiny app is with Google Sheets. This allows you to collect data to the same place from multiple servers, which might happen if you’re running the app locally on more than one computer or through a service like SHINYAPPS.IO. The R package googlesheets4 makes it easy to work with Google Sheets from R.
If you just want to read data from a public Google Sheet, you don’t need any authorisation. Just start your code with gs4_deauth() after you load googlesheets4 (otherwise you’ll be prompted to log in). Then you can read data like this:
library(googlesheets4)
gs4_deauth()
sheet_id <- "https://docs.google.com/spreadsheets/d/1tQCYQrI4xITlPyxb9dQ-JpMDYeADovIeiZZRNHkctGA/"
read_sheet(sheet_id)
## # A tibble: 3 × 2
## number letter
## <dbl> <chr>
## 1 1 A
## 2 2 B
## 3 3 C
However, even if a Google Sheet is publicly editable, you can’t add data to it without authorising your account. If you try, you’ll get the error below.
data <- data.frame(number = 4, letter = "D")
sheet_append(sheet_id, data)
## Error in `gargle_abort_request_failed()`:
## ! Client error: (401) UNAUTHENTICATED
## • Request not authenticated due to missing, invalid, or
## expired OAuth token.
## • API keys are not supported by this API. Expected OAuth2
## access token or other authentication credentials that
## assert a principal. See
## https://cloud.google.com/docs/authentication
##
## Error details:
## • reason: CREDENTIALS_MISSING
## • domain: googleapis.com
## • metadata.method:
## google.apps.sheets.v4.SpreadsheetsService.BatchUpdateSpreadsheet
## • metadata.service: sheets.googleapis.com
You can authorise interactively using the following code (and your own email), which will prompt you to authorise “Tidyverse API Packages” the first time you do this.
gs4_auth(email = "debruine@gmail.com")
However, this won’t work if you want your Shiny apps to be able to access your Google Sheets.
2.2.1 Authorisation for Apps
First, you need to get a token and store it in a cache folder in your app directory. We’re going to call that directory .secrets. Run the following code in your console (NOT in an Rmd file). This will open up a web browser window and prompt you to choose your Google account and authorise “Tidyverse API Packages”.
setwd(app_directory)
gs4_auth(email = "debruine@gmail.com", cache = ".secrets")
# optionally, authorise google drive to search your drive
# googledrive::drive_auth(email = "debruine@gmail.com", cache = ".secrets")
Figure 2.2: Prompts to choose an account, grant permissions, and confirm.
When you have finished, you will see a page that says something like, “Authentication complete. Please close this page and return to R.” In the file pane in RStudio, you should now see a directory called .secrets in the app directory.
If you are using GitHub, you don’t want to save your secret info to a public repository, so run the following code to ignore any directories called .secrets (so they will only exist on your computer and not on GitHub).
usethis::use_git_ignore(".secrets")
usethis::use_git_ignore("*/.secrets")
Now, you can include the following code at the top of your app.R script to authorise the app to read from and write to your files.
gs4_auth(cache = ".secrets", email = "debruine@gmail.com")
2.2.2 Accessing an existing sheet
If you have an existing GOOGLE SHEET, you can access it by URL.
sheet_id <- "https://docs.google.com/spreadsheets/d/1tQCYQrI4xITlPyxb9dQ-JpMDYeADovIeiZZRNHkctGA/"
data <- data.frame(number = 4, letter = "D")
sheet_append(sheet_id, data)
read_sheet(sheet_id)
## # A tibble: 4 × 2
## number letter
## <dbl> <chr>
## 1 1 A
## 2 2 B
## 3 3 C
## 4 4 D
2.2.3 Make a new sheet
You can set up a new Google Sheet with code. You only need to do this once for a sheet that you will use with a Shiny app, and you will need to save the sheet ID. If you don’t specify the tab name(s), the sheet will be created with one tab called “Sheet1”. I recommend making only one sheet per app and saving each table in a separate tab.
id <- gs4_create("demo2", sheets = c("demographics", "questionnaire"))
id
## Spreadsheet name: demo2
## ID: 1tFRznj1nu8cxb4AhbSd6wIylosB97WsId7YIcpXeDm8
## Locale: en_US
## Time zone: Europe/London
## # of sheets: 2
##
## (Sheet name): (Nominal extent in rows x columns)
## demographics: 1000 x 26
## questionnaire: 1000 x 26
Include the ID at the top of your app like this:
SHEET_ID <- "1tFRznj1nu8cxb4AhbSd6wIylosB97WsId7YIcpXeDm8"
2.2.4 Add data
You can add an empty data structure to your sheet by specifying the data types of each column like this:
data <- data.frame(
name = character(0),
birthyear = integer(0),
R_user = logical(0),
score = double(0)
)
write_sheet(data, SHEET_ID, "demographics")
read_sheet(SHEET_ID, "demographics") %>% names()
## [1] "name" "birthyear" "R_user" "score"
Or you can populate the table with starting data.
data <- data.frame(
name = "Lisa",
birthyear = 1976L,
R_user = TRUE,
score = 10.2
)
write_sheet(data, SHEET_ID, "demographics")
read_sheet(SHEET_ID, "demographics")
## # A tibble: 1 × 4
## name birthyear R_user score
## <chr> <dbl> <lgl> <dbl>
## 1 Lisa 1976 TRUE 10.2
Notice that birthyear is a double, not an integer. Google Sheets only have one numeric type, so both doubles and integers are coerced to doubles.
2.2.5 Appending data
Then you can append new rows of data to the sheet.
data <- data.frame(
name = "Robbie",
birthyear = 2007,
R_user = FALSE,
score = 12.1
)
sheet_append(SHEET_ID, data, "demographics")
read_sheet(SHEET_ID, "demographics")
## # A tibble: 2 × 4
## name birthyear R_user score
## <chr> <dbl> <lgl> <dbl>
## 1 Lisa 1976 TRUE 10.2
## 2 Robbie 2007 FALSE 12.1
If you try to append data of a different data type, some weird things can happen. Logical values added to a numeric column are cast as 0 (1) and 1 (TRUE), while numeric values added to a logical column change the column to numeric. If you mix character and numeric values in a column, the resulting column is a column of one-item lists so that each list can have the appropriate data type. (Data frames in R cannot mix data types in the same column.)
data <- data.frame(
name = 1,
birthyear = FALSE,
R_user = 0,
score = "No"
)
sheet_append(SHEET_ID, data, "demographics")
read_sheet(SHEET_ID, "demographics")
## # A tibble: 3 × 4
## name birthyear R_user score
## <list> <dbl> <dbl> <list>
## 1 <chr [1]> 1976 1 <dbl [1]>
## 2 <chr [1]> 2007 0 <dbl [1]>
## 3 <dbl [1]> 0 0 <chr [1]>
You must append data that has the same number and order of columns as the Google Sheet. If you send columns out of order, they will be recorded in the order you sent them, not in the order of the column names. If you send extra columns, the append will fail.
The demo app “radiotables” has a safer version of sheet_append() that you can use when you’re developing on your machine. It’s defined in scripts/gs4.R. This version gracefully handles data with new columns, missing columns, columns in a different order, and columns with a different data type. However, it reads the whole data sheet before deciding whether to append or overwrite the data, which can slow down your app, so is best used only during development when you’re changing things a lot. If it’s not running locally, it uses the original googlesheets4::sheet_append() function instead.
2.2.6 Saving data
If you mix data types in a column, the data frame returned by read_sheet() has list columns for any mixed columns. Dates can also get written in different ways that look the same when you print to the console, but are a mix of characters and doubles, so you have to convert them to strings like this before you can save as CSV.
string_data <- lapply(data, sapply, toString) %>% as.data.frame()
readr::write_csv(string_data, "data.csv")
The demo app “radiotables” has a custom function gs4_write_csv() defined in scripts/gs4.R that does the above for you.
2.3 Exercises
Read others’ data
Read in data from the public google sheet at https://docs.google.com/spreadsheets/d/1QjpRZPNOOL0pfRO6IVT5WiafnyNdahsch1A03iHdv7s/. Find the sheet ID and figure out which sheet has data on US states (assign this to the object states) and which has data on Eutherian mammals (assign this to mammals).
Solution
library(googlesheets4)
gs4_deauth()
sheet_url <- "https://docs.google.com/spreadsheets/d/1QjpRZPNOOL0pfRO6IVT5WiafnyNdahsch1A03iHdv7s/"
sheet_id <- as_sheets_id(sheet_url)
states <- read_sheet(sheet_id, 1)
mammals <- read_sheet(sheet_id, 2)
Read your own data
Create a google sheet online and read its contents in R. You will need to either make it public first (click on the green Share icon in the upper right) or authorise googlesheets to access your account.
Solution
gs4_auth()
my_sheet_url <- ""
mydata <- read_sheet(my_sheet_url)
Write data
Append some data to your google sheet.
2.4 Your App
In the app you’re developing, determine what data need to be saved and set up a google sheet (or local data if you’re having trouble with google). Add the authorisation code to your app (see scripts/gs4.R in the radiotables demo). Write the server function to save data from your app when an action button is pressed.
3 HTML, CSS, and JavaScript
You don’t need to know anything about HTML, CSS and JavaScript to make basic Shiny apps, but a little knowledge can really help you customise your apps. This chapter will cover some of the basics so you have enough vocabulary to get started.
3.1 HTML
HTML stands for Hyper-Text Markup Language, a system for semantically tagging structure and information on web pages. The term “semantically” is important here; HTML should tell you what something is, not how to display it (that’s handled by CSS). This separation helps your apps be accessible to people who use screen readers.
3.1.1 HTML Tags
We learned about the tags() function in Chapter 1 and how it is linked to HTML tags. For example, the R code tags$h2("Methods") creates the HTML <h2>Methods</h2>. It surrounds the text content with a starting tag (<h2>) and an ending tag (</h2>).
Tags create elements, which can be thought of kind of like boxes. An element can contain one or more elements. Elements can have attributes that provide more information such as the element’s id or class, which can be used by CSS or JavaScript to refer to the element or a group of elements.
For example, the following code creates an unordered list (<ul>) with the class "animals". It contains three list item elements (<li>), each with its own id and class.
<ul class="animals">
<li class="mammal" id="aardvark" >Aardvarks</li>
<li class="insect" id="bee">Bees</li>
<li class="mammal" id="capybara">Capybaras</li>
</ul>
You seldom have to write HTML directly in Shiny, but if you have experience with HTML, it can sometimes be easier to create something in HTML than with the relevant Shiny functions. For example, the code above in Shiny would be:
tags$ul(
class = "animals",
tags$li("Aardvark", class = "mammal", id = "aardvark"),
tags$li("Bee", class = "insect", id = "bee"),
tags$li("Capybara", class = "mammal", id = "capybara")
)
Alternatively, you can use HTML() to include raw HTML in a ui function.
HTML('<ul class="animals">
<li class="mammal" id="aardvark" >Aardvarks</li>
<li class="insect" id="bee">Bees</li>
<li class="mammal" id="capybara">Capybaras</li>
</ul>')
3.1.2 Viewing HTML
But the main reason for you to learn a little about HTML is that it can help you to customise the appearance of your Shiny apps using CSS and their behaviour using JavaScript.
Often, you’ll need to find out how to refer to a specific element or group of elements that were created by a shiny ui function. For example, it isn’t obvious how you’d refer to the sidebar tab for "demo_tab" in the following code:
sidebarMenu(
id = "tabs",
menuItem("Tab Title", tabName = "demo_tab", icon = icon("dragon"))
)
If you open the resulting app in a web browser, right click on the page, and choose View Page Source, you’ll (eventually) find that the code above created the HTML below.
<ul class="sidebar-menu">
<li>
<a href="#shiny-tab-demo_tab" data-toggle="tab" data-value="demo_tab">
<i class="fa fa-dragon" role="presentation" aria-label="dragon icon"></i>
<span>Tab Title</span>
</a>
</li>
<div id="tabs" class="sidebarMenuSelectedTabItem" data-value="null"></div>
</ul>
Now you know that the dragon icon is made by an italics tag (<i>) that’s inside an anchor (<a>) with the id #shiny-tab-demo_tab. Therefore, you can change the colour of this icon using the following CSS:
#shiny-tab-demo_tab i { color: red; }
It can be tricky to find what code you’re looking for, but developer tools can help. I use FIREFOX DEVELOPER EDITION when I’m developing web apps, but Chrome also has developer tools. In FireFox, go to Tools > Browser Tools > Web Developer Tools (opt-cmd-I). In Chrome, go to View > Developer > Developer Tools (opt-cmd-I). You can dock the tools to the bottom, right , or left of the window, or as a separate window.
Open the Inspector (FireFox) or Elements (Chrome) tab of the tools and click on the icon that looks like an arrow pointing into a box. When you hover over parts of the web page, now you will see boxes outlining each element. You can click on an element to highlight its HTML in the tools.
Figure 3.1: Viewing the HTML with the inspector.
3.2 CSS
CSS stands for Cascading Style Sheets and is a way to control the visual presentation of HTML on web pages. You can use CSS to change the default appearance of anything on a web page.
3.2.1 CSS Basics
CSS is structured as follows:
selector { property: value; }
Selectors are how you refer to the parts of the HTML you want to style. There are dozens of SELECTORS and they can get very complex. We’ll focus on some basic examples below.
Properties are aspects of the visual style that you want to change, such as color (text color), background-color, or border. Values have specific formats for each property, such as "1px" or "0.5em" to describe lengths, or red or #FF0000 to describe colours.
There are hundreds of PROPERTIES and you can’t memorise them all. I usually Google something like “css font type” or “css underline text” and choose the first link from WW3SCHOOLS.
For example, if you have HTML that looks like this:
<ul class="animals">
<li class="mammal" id="aardvark" >Aardvarks</li>
<li class="insect" id="bee">Bees</li>
<li class="mammal" id="capybara">Capybaras</li>
</ul>
You can refer to different parts of the list in many ways:
CSS | Meaning |
---|---|
.mammal { border: 1px solid green; } | any element with the class "mammal" will get a 1-pixel green border |
ul.animals { border: 1px solid green; } | any unordered list with the class "animals" will get a 1-pixel green border |
.animals li { color: blue; } | any list item element inside an element with the class "animals" will have blue text |
#bee { font-style: italic; } | the element with the id "bee" will be in italics |
.animals li + li { background-color: grey; } | inside an element with the class "animals", any list item that follows another list item will have a grey background |
3.2.2 Styling a single element
You can add styles to most elements that you make with shiny ui functions by adding an argument called style. You don’t need to give them a class or id this way, but this is inefficient if you’re styling many related elements in the same way.
tags$ul(
style = "width: 10em;",
tags$li("Aardvark"),
tags$li("Bee", style = "background-color: yellow;"),
tags$li("Capybara")
)
3.2.3 Inline CSS
You can add CSS to an app inside the header using the style tag. The code below makes the element with the class "animal" "10em" in width (em is a unit of size that is proportional to text size). It also makes the element with the id "bee" italic and gives it a black background-color with yellow text color. If the element is a list item, it makes the marker a bee emoji.
mystyle <- '
.animal { width: 10em; }
#bee {
font-style: italic;
color: yellow;
background-color: black;
}
li#bee::marker { content: "🐝 "; }
'
ui <- fluidPage(tags$head(tags$style(mystyle)),
tags$ul(
class = "animals",
tags$li("Aardvark", class = "mammal", id = "aardvark"),
tags$li("Bee", class = "insect", id = "bee"),
tags$li("Capybara", class = "mammal", id = "capybara")
))
3.2.4 External CSS
For anything longer than a few lines, you can see how this can get tedious. You can put all of your CSS in an external file and reference that in the header instead using tags$link(). The CSS file needs to be inside the www directory to let Shiny know that it’s meant to be included like this. The template we’re using in this class comes with a CSS file called www/custom.css.
tags$head(
tags$link(rel = "stylesheet", type = "text/css", href = "custom.css")
)
Sometimes when you change external files, they don’t seem to update when you test the app. This can be because of caching. You can usually solve this by reloading the app in your web browser, reloading in the web browser with the shift key pressed, stopping the app from running in RStudio with the stop sign icon and starting it up again, and, finally, restarting R.
3.3 JavaScript
JavaScript is a coding language that is very useful for adding dynamic behaviour to web pages. For simple apps, you don’t need to understand any JavaScript, but a little bit can be really helpful for adding advanced behaviour.
3.3.1 shinyjs
The R package shinyjs provides several ways to work with JavaScript in a Shiny app. In order to set it up so that your server function can use shinyjs function, you need to add shinyjs::useShinyjs() somewhere in your ui function.
Here is a list of the shinyjs functions that I find most useful (id refers to an element with the specified ID):
3.3.2 External JS
To do anything more complicated, it’s best to put your JavaScript in an external file in the www directory. You can include a link to this script in the header. The template we’re using in this class comes with a JavaScript file called www/custom.js.
tags$head(
tags$script(src = "custom.js")
)
Shiny apps use JQUERY, a framework for making JavaScript easier to write. It lets you refer to elements using their CSS selectors.
Here is some example code from the www/custom.js file in the basic template.
$(document).on("shiny:connected", function() {
// send window width to shiny
shiny_size = function() {
Shiny.setInputValue("window_width", window.innerWidth);
Shiny.setInputValue("window_height", window.innerHeight);
}
window.onresize = shiny_size;
shiny_size(); // trigger once at start
})
JavaScript is similar to R in some ways, and maddeningly different in others. One big difference is that lines of code have to end with a semi-colon.
In the code above, the function $(document).on("shiny:connected", function() { ... }) is jQuery shorthand for making sure that the code inside doesn’t run until the whole webpage has been downloaded and the extra javascript for shiny is available. Otherwise, you might try to run some code that references an element that hasn’t been created yet (HTML pages don’t always download all in one go) or uses a Shiny javascript function that isn’t available yet.
The we create a new function called shiny_size(), which creates two new Shiny input variables, "window_width" and "window_height", and sets then to the values of the window dimensions (in pixels). The line window.onresize = shiny_size; sets this function to run every time the window is resized and the function is run once at the start to initialise those values.
The javaScript function Shiny.setInputValue(input_id, value) is a way for you to communicate things that happen on the web page to the Shiny app by changing or creating inputs. You can use this inside server() to, for example, change a plot style if input$window_width < 600.
3.4 Further Resources
3.5 Exercises
Clone the basic template for these exercises.
Add HTML
Add the following HTML before the image in demo_tab using `HTML():
<p class="help">For more help, you can go to <a href="https://shiny.rstudio.com/articles/html-tags.html">Customize your UI with HTML</a>.</p>
Hint
Since the HTML has double quotes in it, you either need to escape them or surround the string in single quotes instead.
Solution
demo_tab <- tabItem(
tabName = "demo_tab",
HTML(
'<p class="help">For more help, you can go to <a href="https://shiny.rstudio.com/articles/html-tags.html">Customize your UI with HTML</a>.</p>'
),
imageOutput("logo")
)
Class HTML
Add an unordered list under the paragraph that contains the following text and links:
Solution
demo_tab <- tabItem(
tabName = "demo_tab",
HTML(
'<p class="help">For more help, you can go to <a href="https://shiny.rstudio.com/articles/html-tags.html">Customize your UI with HTML</a>.</p>'
),
tags$ul(tags$li(
tags$a(href = "https://shiny.rstudio.com/articles/tag-glossary.html", "Tags Glossary")
),
tags$li(
tags$a(href = "https://www.w3schools.com/html/", "HTML Tutorial")
)),
imageOutput("logo")
)
Style links
Change the style of all the links to make them hotpink. Use the inline CSS method. As a bonus, change the colour of links when you hover over them, too.
Solution
tags$head(
tags$style("a { color: hotpink; }
a:hover { color: red; }")
)
Style a single link directly
Change the style of just the first link in the list to make it green.
Solution
tags$ul(
tags$li(tags$a(href = "https://shiny.rstudio.com/articles/tag-glossary.html", "Tags Glossary"), style="color: green;"),
tags$li(tags$a(href = "https://www.w3schools.com/html/", "HTML Tutorial"))
)
External CSS
Change the style of just the links inside paragraphs with the class "help" to have an underline. Use external CSS.
Solution
Add the following to www/custom.css:
.help a { text-decoration: underline; }
3.6 Your App
Add some new styles to www/custom.css in your custom app. See if you can figure out how to change any aspects of the default interface that bug you.
4 Structuring a complex app
So far, we’ve been mostly structuring our app entirely in the app.R file, apart from some of the web helper files for CSS and JavaScript. However, once your apps start getting relatively complex, you might find it easier to move some of the code into external .R files and using source() to include them. There are a few things to watch out for when you do this.
4.1 External Server Functions
You can define functions you want to use in your app at the top of the app.R file, but that can make that file difficult to parse pretty quickly. The basic template includes external functions with the line:
source("scripts/func.R") # helper functions
This file contains definitions for the functions debug_msg() and debug_sprintf(). You can add your own custom functions to this file or to another file that you source in separately.
All .R files inside a directory called R will run before the app starts up, even if you don’t source them into the app. You can use this to set up any functions your app needs without having to use source(), but I prefer to explicitly include external files, so I keep external functions in a directory called scripts.
4.1.1 Sourcing Locally
It can be tricky to use shiny functions to external files. For example, you can’t just move the contents of server() to an external file called scripts/logo.R and source the file in like this:
server <- function(input, output, session) {
source("scripts/logo.R")
}
You’ll get an error like: “Error in output$logo <- renderImage({ : object ‘output’ not found”. This is because the input and output objects only work like you’d expect when they are inside server()
However, you can source in external code inside server() by setting the local argument to TRUE.
server <- function(input, output, session) {
source("scripts/logo.R", local = TRUE)
}
You might find it useful to break up parts of the server logic for a very big app into separate files like this, but it’s more common to keep any code that uses reactive functions inside server() in the app.R file, and move large sections of code inside those functions to externally defined functions.
For example, you could define the function logo_image() in the external file scripts/logo.R like this:
logo_image() <- function() {
list(src = "www/img/shinyintro.png",
width = "300px",
height = "300px",
alt = "ShinyIntro hex logo")
}
The following in the app.R file keeps the reactive function renderImage() inside server(), but lets you reduce the number of lines of code.
source("scripts/logo.R")
server <- function(input, output, session) {
source("scripts/logo.R", local = TRUE)
output$logo <- renderImage(logo_image(), deleteFile = FALSE)
}
4.1.2 Inputs and Outputs
The objects input and output aren’t available by default to externally defined functions. Let’s add an action button to the ui for our app, actionButton("change", "Change Image"), and change the logo_image() function so that it returns the ShinyIntro logo on odd-numbered clicks of the change button, and the psyTeachR logo on even-numbered clicks.
logo_image <- function() {
odd_clicks <- input$change%%2 == 1
src <- ifelse(odd_clicks,
"www/img/shinyintro.png",
"www/img/psyteachr.png")
list(src = src,
width = "300px",
height = "300px",
alt = "ShinyIntro hex logo")
}
If you try to run this, you’ll get an error message like, “Error in logo_image: object ‘input’ not found”. This is because the external function doesn’t have access to reactive objects like input, output, session, or any reactiveValues().
The best solution is to pass any variables to the function that you need. In some circumstances, you can pass the whole input object, but that’s seldom necessary.
Here, we change logo_image() to take a single argument called change and replace input$change with this argument.
logo_image <- function(change) {
odd_clicks <- change%%2 == 1
src <- ifelse(odd_clicks,
"www/img/shinyintro.png",
"www/img/psyteachr.png")
list(src = src,
width = "300px",
height = "300px",
alt = "ShinyIntro hex logo")
}
Then we just have to pass the value of input$change to logo_image() inside renderImage(), where the input object is available.
server <- function(input, output, session) {
output$logo <- renderImage({
logo_image(input$change)
}, deleteFile = FALSE)
}
Don’t worry too much if this isn’t making a lot of sense yet. The main thing I want you to take away from this section is that when you try to move some server code to external files, you might get errors (I frequently do). I hope that will remind you of this lesson and you’ll have a better idea about where to start looking for the solution.
4.2 External UI Files
Defining a complex UI can be very challenging. The basic template uses a pattern that I find helpful with apps that have multiple tab items. I assign each tab to an object and then include the tabs of the app in dashboardBody() like this:
tabItems(
intro_tab,
questionnaire_tab,
feedback_tab,
info_tab
)
For a simple app, you can define the tabs in app.R just before you define the ui. You can do the same for any components of the ui, such as dashboardHeader() or dashboardSidebar(). When the sections start getting complex, you can move them into external files and source them in.
4.2.1 UI Lists
When parts of the UI repeat or can be created programmatically instead of manually, you can use apply() or map() functions to create a list of UI components. It can be a little tricky to figure out how to add a list of components into the UI, but this can be accomplished with do.call().
Here’s an example of how you would programatically create select inputs for each categorical column of the starwars dataset from dplyr and add them to a box().
# get the categorical columns
col_is_char <- sapply(starwars, is.character)
categorical_cols <- names(starwars)[col_is_char]
# set up the selectInputs
select_inputs <- lapply(categorical_cols, function(col) {
unique_vals <- unique(starwars[[col]])
selectInput(inputId = col, label = col, choices = unique_vals)
})
# add container arguments to select_inputs
select_inputs$title = "Select the Categories"
select_inputs$solidHeader = TRUE
select_inputs$width = 4
# add to container
select_box <- do.call(box, select_inputs)
4.3 Exercises
UI
Clone the reactive_demo, move the boxes in the ui to an external file, and source them in.
Server
Make a custom function in scripts/func.R that creates the plot. Use that in server().
4.4 Your App
In the app you’re developing, see if there are any long functions inside reactive functions in server() that can be moved to scripts/func.R or another external file. Move each tab into an external file and source it into app.R.
5 Debugging and error handling
Bugs are a part of coding. A great coder isn’t someone who writes bug-free code on their first try (this is an unachievable goal), but rather someone who knows how to efficiently catch bugs. This section presents a few simple ways to debug your Shiny app.
5.1 RStudio Console Messages
Sending messages to the console is a simple way to debug your code.
I like to keep track of what functions are being called by starting every function inside the server function with a message. The template includes a custom message logging function that helps you use this with both development and deployed apps: debug_msg().
# display debugging messages in R (if local)
# and in the console log (if running in shiny)
debug_msg <- function(...) {
is_local <- Sys.getenv('SHINY_PORT') == ""
in_shiny <- !is.null(shiny::getDefaultReactiveDomain())
txt <- toString(list(...))
if (is_local) message(txt)
if (in_shiny) shinyjs::runjs(sprintf("console.debug(\"%s\")", txt))
}
For example, the code below prints “questionnaire submitted” every time the action button q_submit is pressed. It prints to the javascript console and also to the RStudio console when you’re developing.
observeEvent(input$q_submit, {
debug_msg("questionnaire submitted")
# rest of code ...
})
5.2 JavaScript Console
I use FIREFOX DEVELOPER EDITION when I’m developing web apps, but Chrome also has developer tools. In FireFox, go to Tools > Browser Tools > Web Developer Tools (opt-cmd-I). In Chrome, go to View > Developer > Developer Tools (opt-cmd-I). You can dock the tools to the bottom, right , or left of the window, or as a separate window.
Figure 5.1: Javascript consoles in FireFox Developer Edition and Chrome.
Shiny puts a lot of info you won’t care about into the logs, so debug_msg() writes messages to the debug console. You can filter just those messages by choosing only Debug in FireFox or Verbose in Chrome.
5.3 Showcase Mode
You can view an app in showcase mode by setting “DisplayMode” to “Showcase” (instead of “Normal”) in the DESCRIPTION file in the app directory. When you’re in this mode, you can see your app code, css files, and javascript files. The functions in server() will highlight in yellow each time they are run. However, this isn’t much help if many of your functions are in external files or you are using modules. Also, if your script is very long, you won’t be able to see the highlighting unless you’ve scrolled to the right section, so I find it more straightforward to use the message method described above.
Title: Questionnaire Template
Author: Lisa DeBruine
License: CC-BY-4.0
DisplayMode: Showcase
Type: Shiny
Figure 5.2: Showcase mode.
5.4 tryCatch
You’ve probably experienced the greyed out screen of a crashed app more than enough now. In development, the next step is to look at the console to see if you have a warning or error message. If you’re lucky, you can figure out where in the code this is happening (this is easier if you start all your functions with a debug message) and fix it.
However, sometimes there are errors that are difficult to prevent. For example, you can try to restrict inputs so the users only enter numeric values using numericInput(), but many browsers will let you enter text values anyways (they cause a value of NA). To avoid crashing the whole app, you can wrap potentially error-triggering code in tryCatch().
For example, the code below will cause an error because you can’t add a number and a letter.
input <- list(n1 = 10, n2 = "A")
sum <- input$n1 + input$n2
## Error in input$n1 + input$n2: non-numeric argument to binary operator
The following code tries to run the code inside the curly brackets ({}), but if it creates an error, the error function will run. The object e is the error object, and you can print the message from it using debug_msg() (this won’t crash the app).
sum <- tryCatch({
input$n1 + input$n2
}, error = function(e) {
debug_msg(e$message)
return(0)
})
The return value from the error message is the value assigned to sum if there is an error. Sometimes it won’t make sense to have a default value, or the code you’re checking doesn’t have a return value. In that case, you can just put all the code inside the brackets and not return anything from the error function.
tryCatch({
sum <- input$n1 + input$n2
output$sum <- renderText(sum)
}, error = function(e) {
debug_msg(e$message)
})
5.5 Input Checking
The user above might be frustrated if they’ve made a mistake that causes an error and don’t know what it was. You can help prevent errors and make the experience of using your app nicer by doing input checking and sending your users useful messages.
5.5.1 Modal Dialogs
One method is to check your input values, generate an appropriate error message if anything is wrong, and show the message in a modalDialog().
observeEvent(input$submit, {
# check inputs
input_error <- dplyr::case_when(
!is.numeric(input$n1) ~ "N1 needs to be a number",
!is.numeric(input$n2) ~ "N2 needs to be a number",
TRUE ~ ""
)
if (input_error != "") {
showModal(modalDialog(
title = "input_error",
input_error,
easyClose = TRUE
))
return() # exit the function here
}
# no input errors
sum <- input$n1 + input$n2
add_text <- sprintf("%d + %d = %d", input$n1, input$n2, sum)
output$n1_plus_n2 <- renderText(add_text)
})
5.5.2 Validate
You can also use validate() and need() to test for required inputs to an output. However, this only works from inside a render function or a reactive function called inside a render function. I prefer to make my own pop-up messages like above, because they will work from any type of function.
server <- function(input, output) {
add_text <- reactive({
input$add # triggers reactive
n1 <- isolate(input$n1)
n2 <- isolate(input$n2)
validate(
need(!is.na(n1), "The first value must a number"),
need(!is.na(n2), "The second value must a number")
)
sprintf("%d + %d = %d", n1, n2, n1 + n2)
})
output$n1_plus_n2 <- renderText(add_text())
}
5.6 Further Resources
5.7 Exercises
Required selections
Write an app that creates the plot below for any checked values of a checkboxGroupInput() that lists all the orders in msleep.
# this input is just an example for testing the code below
input <- list(orders = c("Carnivora", "Chiroptera", "Primates"))
# input <- list(orders = c()) # check this to see what happens with no selections
filtered_data <- dplyr::filter(msleep, order %in% input$orders)
ggplot(filtered_data, aes(x = sleep_total, fill = order)) +
geom_histogram(binwidth = 1) +
facet_wrap(~order)
Add error checking to the app to deal with what happens when input$order has no selections.
5.8 Your App
In the app you’re developing, add debug_msg() messages to the start of any reactive functions. Run your app and look at the Rstudio console and JavaScript console outputs.
Find anywhere that a user could enter invalid information or cause an error and add a way to handle this.
6 Contingent Display
6.1 Hide and Show
I frequently want to make some aspect of a shiny app contingent on the state of another aspect, such as only showing a text input of the value of a select input is “other”. You can use the hide() and show() functions from shinyjs to accomplish this easily.
When you set up the UI, wrap any elements that should be hidden at the start in hidden().
# in the ui
box(title = "Questions",
solidHeader = TRUE,
selectInput("first_pet", "What was your first pet?",
c("", "dog", "cat", "ferret", "other")),
hidden(textInput("first_pet_other", NULL,
placeholder = "Specify the other pet"))
)
Then set up the hide and show logic in server().
# in the server
observeEvent(input$first_pet, {
if (input$first_pet == "other") {
show("first_pet_other")
} else {
hide("first_pet_other")
}
})
6.1.1 Groups
Sometimes you need to hide and show a group of elements, depending on something else. You can wrap the grouped elements in a div tag with an id and hide and show that id.
For example, it doesn’t make sense to show the questions above to someone who has never had a pet. Add a selectInput() before the previous two questions, and then wrap those questions in tags$div() with an id of "first_pet_grp"
# replace in ui
box(
title = "Questions",
solidHeader = TRUE,
selectInput("had_pet", "Have you ever had a pet?", c("", "Yes", "No")),
hidden(tags$div(
id = "first_pet_grp",
selectInput("first_pet", "What was your first pet?",
c("", "dog", "cat", "ferret", "other")),
textInput("first_pet_other", NULL,
placeholder = "Specify the other pet")
))
)
Then add the following code to the server function to hide or show first_pet_grp depending on the value of had_pet. The server code above will take care of whether or not first_pet_other is visible.
# add to server
observeEvent(input$had_pet, {
if (input$had_pet == "Yes") {
show("first_pet_grp")
} else {
hide("first_pet_grp")
}
})
Try to figure out what could go wrong if you didn’t wrap “first_pet” and “first_pet_other” in a group, and instead just hid or showed “first_pet” and “first_pet_other” depending on the value of has_pet?
6.1.2 Toggle
Sometimes you need to change the visibility of an element when something happens, rather than specifically hide or show it. You can use toggle() to hide an element if it’s visible and show it if it’s hidden.
Add an actionButton() to the sidebar menu (not inside the box) and give the box an id of "pet_box". Any element that you might want to refer to in the code needs an id.
# add to ui
actionButton("toggle_pet_box", "Toggle Pet Questions")
Now, whenever you click the “toggle_pet_box” button, the contents of “pet_box” will toggle their visibility.
# add to server
observeEvent(input$toggle_pet_box, {
toggle("pet_box")
})
What would go wrong if you put the button inside the box?
6.2 Changing Styles
You can use addClass(), removeClass(), and toggleClass() to change element classes. You usually want to do this with classes you’ve defined yourself.
Add the following style to the www/custom.css file.
.notice-me {
color: red;
text-decoration: underline;
font-weight: 800;
}
And add this box to the ui:
box(title = "Notice", solidHeader = TRUE,
p(id = "notice_text", "Please pay attention to this text."),
actionButton("add_notice", "Notice Me"),
actionButton("remove_notice", "Ignore Me"),
actionButton("toggle_notice", "Toggle Me")
)
This code adds the class "notice-me" to the paragraph element "notice_text" whenever the “add_notice” button is pressed.
observeEvent(input$add_notice, {
addClass("notice_text", "notice-me")
})
Guess how you would use removeClass(), and toggleClass() with the buttons set up above.
6.2.1 Changing non-shiny elements
Unfortunately, not all elements on the web page have an ID that can be altered by addClass() or removeClass(). For example, the skin of a shinydashboard app is determined by the css class of the body element. However, we can use runjs() to run any arbitrary JavaScript code.
Add the following action button into the sidebarMenu().
actionButton("random_skin", "Random Skin")
The jQuery code below changes the skin of your app on a button press by removing all possible skin-color classes and adding a random one.
observeEvent(input$random_skin, {
skins <- c("red", "yellow", "green", "blue", "purple", "black")
skin_color <- sample(skins, 1)
js <- sprintf("$('body').removeClass('%s').addClass('skin-%s');",
paste(paste0("skin-", skins), collapse = " "),
skin_color)
shinyjs::runjs(js)
})
Changing the skin color with a button press isn’t something you’ll easily find documented in online materials. I figured it out through looking at how the underlying html changed when I changed the skin color in the app code. Hacks like this require lots of trial and error, but get easier the more you understand about html, css and JavaScript.
6.3 Changing input options
The relevant options in a selectInput() or radioButton() may change depending on the values of other inputs. Sometimes you can accommodate this by creating multiple versions of a input and hiding or showing. Other times you may wish to update the input directly.
Add the following box to the ui.
box(title = "Data", solidHeader = TRUE, width = 12,
selectInput("dataset", "Choose a dataset", c("mtcars", "sleep")),
checkboxGroupInput("columns", "Select the columns to show", inline = TRUE),
tableOutput("data_table")
)
First, set up the code to display the correct data in the table.
mydata <- reactive({
get(input$dataset, "package:datasets")
})
output$data_table <- renderTable(mydata())
Now we need to set the options for "columns" depending on which “dataset” is selected.
observe({
col_names <- names(data())
debug_msg(col_names)
updateCheckboxGroupInput(inputId = "columns",
choices = col_names,
selected = col_names)
})
Finally, we can add some code to select only the checked columns to display.
observe({
full_data <- get(input$dataset, "package:datasets")
col_names <- names(full_data)
updateCheckboxGroupInput(
inputId = "columns",
choices = col_names,
selected = col_names,
inline = TRUE
)
})
Why do we have to get the dataset again instead of using the data from mydata()?
Finally, alter the reactive function to only show the selected columns.
mydata <- reactive({
d <- get(input$dataset, "package:datasets")
d[input$columns]
})
What happens when you unselect all the columns? How can you fix this?
6.4 Further Resources
6.5 Exercises
Filtered data
Create an app where you use inputs to filter a dataset and display a table of the filtered dataset. For example, with the msleep dataset, you could have inputs that select vore, order and conservation. Since some values will exclude categories (e.g., there are no omnivores in the order Cetacea), update the available categories in each input when values are selected. Make sure you have a way to reset the values.
6.6 Your App
Check for places in your app that could use contingency.
7 Sharing your Apps
7.1 shinyapps.io
shinyintro::clone("input_demo", "mytestapp")
Open the app.R file and go to File > Publish... in the menu (or click on the blue icon in the upper right corner of the source pane). Make sure these are the right files for your app, edit the title if you want, and click Publish. A web browser window will open after a few seconds showing your app online! You can now share it with your friends and colleagues.
If publishing fails, check the Console pane. If you already have too many apps on shinyapps.io, you’ll see the message, “You have reached the maximum number of applications allowed for your account.” You can archive some of your apps from the shinyapps.io dashboard if this is the problem.
7.2 Self-hosting a shiny server
Setting up a shiny server is beyond the scope of this class, but if you have access to one, you can ask the administrator how to access the correct directories and upload your app directories there.
This solution is good if you want to save data locally and do not want to use Google Sheets. You can’t save data locally on shinyapps.io.
If you save data locally on a shiny server, you may need to change the owner or permissions of the directory you save data in so that the web user can write to it. Ask the administrator of the server for help if this doesn’t make any sense to you.
7.3 GitHub
GitHub is a great place to organise and share your code using version control. You can also use it to host Shiny app code for others to download and run on their own computer.
See Appendix B for instructions on how to set up git and a GitHub account. Set up a github access token with usethis::create_github_token(). Your web browser will open and you’ll be asked to log into your GitHub account and then asked to authorise a new token. Accept the defaults and click OK at the bottom of the page. In RStudio, run gitcreds::gitcreds_set() and follow the instructions to save the token.
Then, to share an app with people who use R, make a project that contains your app.R file and any related files. If you aren’t already using version control for this project, make sure all of your files are saved and type usethis::use_git() into the console. Choose Yes to commit and Yes to restart R.
Make a new GitHub repository with usethis::use_github(protocol=“https”); check that the suggested title and description are OK. If you choose the affirmative response (not always the same number), you’ll see some messages and your web browser will open the github repository page.
Now you can share your app with others by sending them the repository link. They can access your repository in RStudio by starting a New Project... from version control, using the URL that is shown when you click on the green Code button on the repository page (something like “https://github.com/account/repository.git”). They can run your app the same way you do when developing it, by opening the app.R file and clicking the Run button.
To update your files on GitHub, you need to commit any changes you make using the Git tab in the upper right pane. Click on the checkbox of any files you want to update, click Commit, and write a message to yourself explaining the changes (this will be publicly viewable on GitHub, so try to be professional, but you can use emojis 😱🤪😍).
Committing just creates a snapshot of the files on your computer so you can look at previous versions. To update the files on GitHub, you need to push the updates using the green up arrow button.
Git and GitHub can be tricky. HAPPY GIT WITH R by Jenny Bryan is a fantastic in-depth book anbout how to work with git in R and RStudio.
7.4 In an R package
You can put your app in a custom R package to make it even easier for people to run the app. The usethis package is incredibly helpful for setting up packages.
mypackagename <- "mypackagename" # change this
usethis::create_package(mypackagename)
usethis::use_ccby_license()
# add packages your app uses
usethis::use_package("shiny")
usethis::use_package("shinydashboard")
# add the directory for your apps
dir.create("inst")
dir.create("inst/apps")
Copy any apps you want to include in this package into the inst/apps directory.
Now, create the app function by running usethis::edit_file("R/app.R") and copy the following text into the app.R file that just opened. Replace "default_app" with the directory name of the app that you want to open if a user doesn’t type any name in at all.
#' Launch Shiny App
#'
#' @param name The name of the app to run
#' @param ... arguments to pass to shiny::runApp
#'
#' @export
#'
app <- function(name = "default_app", ...) {
appDir <- system.file(paste0("apps/", name), package = "mypackagename")
if (appDir == "") stop("The shiny app ", name, " does not exist")
shiny::runApp(appDir, ...)
}
Next, open the DESCRIPTION file and edit the title, author and description. Now run the following code in the console.
devtools::document()
devtools::install()
This will create the help documentation for your package function and install the package on your computer. You should now be able to run your app with mypackagename::app().
Set up git and save your package to GitHub to share it with others:
usethis::use_git()
usethis::use_github(protocol="https")
Once it’s uploaded to GitHub, other people can install it with the following code:
devtools::install_github("myaccountname/mypackagename")
7.5 Further Resources
7.6 Exercises
Shinyapps.io
GitHub
R Package
7.7 Your App
How will users need to access your app? Will they be R users who can download it and run it on their own computers? Or will you need to find a host online? Choose and implement a sharing method for your custom app. Send a friend (or your instructor) directions to access and run it.
8 Customized reports
While the best part of Shiny apps is their interactivity, sometimes your users need to download data, images, or a static report. This section will show you how.
8.1 Download Data
First, we need to add the appropriate UI to our questionnaire app. Create a new tab called "report_tab" with two downloadButton()s, one for the pets data and one for the food data.
report_tab <- tabItem(
tabName = "report_tab",
box(
id = "download_box",
title = "Downloads",
solidHeader = TRUE,
downloadButton("pet_data_dl", "Pets Data"),
downloadButton("food_data_dl", "Food Data")
)
)
Remember to add this to tabItems() in dashboardBody() and also add a corresponding menuItem() in sidebarMenu(). Run the app to make sure the UI looks like you expect before you proceed.
Now we need to add code to server() to handle the downloads. downloadButton() is a special type of output that is handled by downloadHandler(). This function takes two arguments, a function to create the filename and a function to create the content.
### pet_data_dl ----
output$pet_data_dl <- downloadHandler(
filename = function() {
debug_msg("pet_data_dl")
paste0("pet-data_", Sys.Date(), ".csv")
},
content = function(file) {
gs4_write_csv(v$pet_summary_data, file)
}
)
Instead of write.csv() or readr::write_csv(), here we’re using gs4_write_csv() (defined in scripts/gs4.R) because googlesheets can return list columns that cause errors when saving to CSV without some preprocessing.
8.2 Download Images
Now that we need to use the summary plot in more than one place, it doesn’t make sense to build it twice. Move all of the code from the renderPlot() for output$pet_summary into a reactive() called pet_summary_plot. Then we can build the plot whenever the inputs change and refer to it anywhere as pet_summary_plot().
### pet_summary_plot ----
pet_summary_plot <- reactive({ debug_msg("pet_summary_plot")
# code from output$pet_summary ...
})
### pet_summary ----
output$pet_summary <- renderPlot({ debug_msg("pet_summary")
pet_summary_plot()
})
The downloadHandler() works the same as for downloading a CSV file. You can use ggsave() to write the plot.
# pet_plot_dl ----
output$pet_plot_dl <- downloadHandler(
filename = function() {
paste0("pet-plot_", Sys.Date(), ".png")
},
content = function(file) {
ggsave(file,
pet_summary_plot(),
width = 7,
height = 5)
}
)
Add numeric inputs to the UI to let the user specify the downloaded plot width and height.
Solution
# add to report_tab ui
numericInput("plot_width", "Plot Width (inches)", 7, min = 1, max = 10)
numericInput("plot_height", "Plot Height (inches)", 5, min = 1, max = 10)
### pet_plot_dl ----
output$pet_plot_dl <- downloadHandler(
filename = function() {
debug_msg("pet_plot_dl")
paste0("pet-plot_", Sys.Date(), ".png")
},
content = function(file) {
ggsave(
file,
pet_summary_plot(),
width = input$plot_width,
height = input$plot_height
)
}
)
8.3 R Markdown
You can render an R Markdown report for users to download.
First, you need to save an R Markdown file (save the one below as reports/report.Rmd). You need to set up params for any info that you want to pass from the Shiny app in th YAML header. Here, we will dynamically update the title, data, and plot. You can set the values to NULL or another default value.
---
title: "`r params$title`"
date: "`r format(Sys.time(), '%d %B, %Y')`"
output: html_document
params:
title: Report
data: NULL
plot: NULL
---
Then you can refer to these params in the R Markdown file as params$name. If you knit the report, these will take on the default values.
```r
n_responses <- nrow(params$data)
n_sessions <- params$data$session_id %>%
unique() %>%
length()
```
We asked people to rate how much they like pets. We have obtained `r n_responses` responses from `r n_sessions` unique sessions.
## Summary Plot
```r
params$plot
```
The content function uses rmarkdown::render() to create the output file from Rmd. We are using html_document as the output type, but you can also render as a PDF or Word document if you have pandoc or latex installed. Include the title, data and plot as a named list to the params argument.
### pet_report_dl ----
output$pet_report_dl <- downloadHandler(
filename = function() {
debug_msg("pet_report_dl")
paste0("pet-report_", Sys.Date(), ".html")
},
content = function(file) {
rmarkdown::render("reports/report.Rmd",
output_file = file,
params = list(
title = "Pet Report",
data = v$pet_summary_data,
plot = pet_summary_plot()
),
envir = new.env(),
intermediates_dir = tempdir())
}
)
Setting the envir argument to new.env() makes sure that settings in your Shiny app, such as a default ggplot theme, can’t affect the rendered file, but also makes it so that the R Markdown code will not have access to any objects from your app, such as input or v$summary_data, unless you pass them as parameters.
On your own computer, you don’t need to set intermediates_dir = tempdir(), but you will need to do this if you want to deploy your app on a shiny server. When rmarkdown renders an Rmd file, it creates several intermediate files in the working directory and then deletes them. you have permission to write to the app’s working directory on your own computer, but might not on a shiny server. tempdir() is almost always a safe place to write temporary files to.
8.4 Further Resources
8.5 Exercises
Food Data
Create a button that downloads the food data.
Solution
# add to report_tab ui ----
downloadButton("food_data_dl", "Food Data")
### food_data_dl ----
output$food_data_dl <- downloadHandler(
filename = function() {
debug_msg("food_data_dl")
paste0("food-data_", Sys.Date(), ".csv")
},
content = function(file) {
gs4_write_csv(v$food_summary_data, file)
}
)
Food Image
Create a button that downloads the food summary plot
Solution
# add to report_tab ui ----
downloadButton("food_plot_dl", "Food Plot")
### food_summary_plot ----
food_summary_plot <- reactive({ debug_msg("food_summary_plot")
# code from output$food_summary ...
})
### food_summary ----
output$food_summary <- renderPlot({ debug_msg("food_summary")
food_summary_plot()
})
### food_plot_dl ----
output$food_plot_dl <- downloadHandler(
filename = function() {
debug_msg("food_plot_dl")
paste0("food-plot_", Sys.Date(), ".png")
},
content = function(file) {
ggsave(
file,
food_summary_plot(),
width = input$plot_width,
height = input$plot_height
)
}
)
Food Report
Create a downloadable report for the food data.
Solution
# add to report_tab ui ----
downloadButton("food_report_dl", "Food Report")
### food_report_dl ----
output$food_report_dl <- downloadHandler(
filename = function() {
debug_msg("food_report_dl")
paste0("food-report_", Sys.Date(), ".html")
},
content = function(file) {
rmarkdown::render("reports/report.Rmd",
output_file = file,
params = list(
title = "Food Report",
data = v$food_summary_data,
plot = food_summary_plot()
),
envir = new.env(),
intermediates_dir = tempdir())
}
)
8.6 Your app
What might users want to download from your app? Include data, image, or report download if that is applicable to your app.
9 Shiny modules for repeated structures
If you find yourself making nearly identical UIs or server functions over and over in the same app, you might benefit from modules. This is a way to define a pattern to use repeatedly.
9.1 Modularizing the UI
The two tabPanels below follow nearly identical patterns. You can often identify a place where modules might be useful when you use a naming convention like "{base}_{type}" for the ids.
iris_tab <- tabPanel(
"iris",
selectInput("iris_dv", "DV", choices = names(iris)[1:4]),
plotOutput("iris_plot"),
DT::dataTableOutput("iris_table")
)
mtcars_tab <- tabPanel(
"mtcars",
selectInput("mtcars_dv", "DV", choices = c("mpg", "disp", "hp", "drat")),
plotOutput("mtcars_plot"),
DT::dataTableOutput("mtcars_table")
)
The first step in modularising your code is to make a function that creates the UIs above from the base ID and any other changing aspects. In the example above, the choices are different for each selectInput(), so we’ll make a function that has the arguments id and choices.
The first line of a UI module function is always ns <- NS(id), which creates a shorthand way to add the base id to the id type. So instead of the selectInput()’s name being "iris_dv" or "mtcars_dv", we set it as ns(dv). All ids need to use ns() to add the namespace to their ID.
tabPanelUI <- function(id, choices) {
ns <- NS(id)
tabPanel(
id,
selectInput(ns("dv"), "DV", choices = choices),
plotOutput(ns("plot")),
DT::dataTableOutput(ns("table"))
)
}
Now, you can replace two tabPanel definitions with just the following code.
iris_tab <- tabPanelUI("iris", names(iris)[1:4])
mtcars_tab <- tabPanelUI("mtcars", c("mpg", "disp", "hp", "drat"))
9.2 Modularizing server functions
In our original code, we have four functions that create the two output tables and two output plots, but these are also largely redundant.
output$iris_table <- DT::renderDataTable({
iris
})
output$iris_plot <- renderPlot({
ggplot(iris, aes(x = Species,
y = .data[[input$iris_dv]],
fill = Species)) +
geom_violin(alpha = 0.5, show.legend = FALSE) +
scale_fill_viridis_d()
})
output$mtcars_table <- DT::renderDataTable({
mtcars
})
output$mtcars_plot <- renderPlot({
# handle non-string grouping
mtcars$vs <- factor(mtcars$vs)
ggplot(mtcars, aes(x = vs,
y = .data[[input$mtcars_dv]],
fill = vs)) +
geom_violin(alpha = 0.5, show.legend = FALSE) +
scale_fill_viridis_d()
})
The second step to modularising code is creating a server function. You can put all the functions the relate to the inputs and outputs in the UI function here, so we will include one to make the output table and one to make the output plot.
The server function takes the base id as the first argument, and then any arguments you need to specify things that change between base implementations. Above, the tables show different data and the plots use different groupings for the x axis and fill, so we’ll add arguments for data and group_by.
A server function always contains moduleServer() set up like below.
tabPanelServer <- function(id, data, group_by) {
moduleServer(id, function(input, output, session) {
# code ...
})
}
No you can copy in one set of server functions above, remove the base name (e.g., “iris_” or “mtcars_”) from and inputs or outputs, and replace specific instances of the data or grouping columns with data and group_by.
tabPanelServer <- function(id, data, group_by) {
moduleServer(id, function(input, output, session) {
output$table <- DT::renderDataTable({
data
})
output$plot <- renderPlot({
# handle non-string groupings
data[[group_by]] <- factor(data[[group_by]])
ggplot(data, aes(x = .data[[group_by]],
y = .data[[input$dv]],
fill = .data[[group_by]])) +
geom_violin(alpha = 0.5, show.legend = FALSE) +
scale_fill_viridis_d()
})
})
}
In the original code, the grouping variables were unquoted, but it’s tricky to pass unquoted variable names to custom functions, and we already know how to refer to columns by a character object using .data[[char_obj]].
The grouping column Species in iris is already a factor, but recasting it as a factor won’t hurt, and is required for the mtcars grouping column vs.
Now, you can replace the four functions inside the server function with these two lines of code.
tabPanelServer("iris", data = iris, group_by = "Species")
tabPanelServer("mtcars", data = mtcars, group_by = "vs")
Our example only reduced our code by 4 lines, but it can save a lot of time, effort, and debugging on projects with many similar modules. For example, if you want to change the plots in your app to use a different geom, now you only have to change one function instead of two.
9.3 Further Resources
9.4 Exercises
Repeat Example
Try to implement the code above on your own.
New Instance
Add a new tab called “diamonds” that visualises the diamonds dataset. Choose the columns you want as choices in the selectInput() and the grouping column.
UI Solution
You can choose any of the numeric columns for the choices.
diamonds_tab <- tabPanelUI("diamonds", c("carat", "depth", "table", "price"))
Server Solution
You can group by any of the categorical columns: cut, color, or clarity.
tabPanelServer("diamonds", data = diamonds, group_by = "cut")
Altering modules
UI Solution
You need to add a new selectInput() to the tabPanel(). Remember to use ns() for the id. The choices for this select will also differ by data set, so you need to add group_choices to the arguments of this function.
tabPanelUI <- function(id, choices, group_choices) {
ns <- NS(id)
tabPanel(
id,
selectInput(ns("dv"), "DV", choices = choices),
selectInput(ns("group_by"), "Group By", choices = group_choices),
plotOutput(ns("plot")),
DT::dataTableOutput(ns("table"))
)
}
Server Solution
You no longer need group_by in the arguments for this function because you are getting that info from an input.
Instead of changing group_by to input$group_by in three places in the code below, I just added the line group_by <- input$group_by at the top of moduleServer().
tabPanelServer <- function(id, data) {
moduleServer(id, function(input, output, session) {
group_by <- input$group_by
# rest of the code is the same ...
})
}
New module
There is a fluidRow() before the tabsetPanel() in the ui that contains three infoBoxOutput() and three renderInfoBoxOutput() functions in the server function.
Modularise the info boxes and their associated server functions.
UI Function
infoBoxUI <- function(id, width = 4) {
ns <- NS(id)
infoBoxOutput(ns("box"), width)
}
Server Function
infoBoxServer <- function(id, title, fmt, icon, color = "purple") {
moduleServer(id, function(input, output, session) {
output$box <- renderInfoBox({
infoBox(title = title,
value = format(Sys.Date(), fmt),
icon = icon(icon),
color = color)
})
})
}
UI Code
In the ui, replace the fluidRow() with this:
fluidRow(
infoBoxUI("day"),
infoBoxUI("month"),
infoBoxUI("year")
)
Server Code
In server(), replace the three renderInfoBox() with this:
infoBoxServer("year", "Year", "%Y", "calendar")
infoBoxServer("month", "Month", "%m", "calendar-alt")
infoBoxServer("day", "Day", "%d", "calendar-day")
9.5 Your app
What you could modularise in your custom app?
(APPENDIX) Appendices
10 Installing and Updating
Installing R and RStudio is usually straightforward. The sections below explain how and THERE IS A HELPFUL YOUTUBE VIDEO HERE. If you have an older installation, you will want to update it to the newest versions of R and RStudio your computer can use.
10.1 Base R
10.1.1 Installing R
INSTALL BASE R. Choose the download link for your operating system (Linux, Mac OS X, or Windows).
If you have a Mac, install the latest release from the newest R-x.x.x.pkg link (or a legacy version if you have an older operating system). You may also need to install XQUARTZ to be able to use some visualisation packages.
If you are installing the Windows version, choose the “base” subdirectory and click on the download link at the top of the page.
If you are using Linux, choose your specific operating system and follow the installation instructions.
10.1.2 Updating R
Finally, you may also wish to update R itself. The key thing to be aware of is that when you update R, if you just download the latest version from the website, you will lose all your packages.
10.1.2.1 Windows
The easiest way to update R on Windows and not cause yourself a huge headache is to use the installr package. When you use the updateR() function, a series of dialogue boxes will appear. These should be fairly self-explanatory but there is a full step-by-step guide available for how to use installr, the important bit is to select “Yes” when it asked if you would like to copy your packages from the older version of R.
# Install the installr package
install.packages("installr")
# Run the update function
installR::updateR()
10.1.2.2 Mac
For a Mac, you can use the UPDATER package. You’ll need to install this from GitHub. You will be asked to type your system password (that you use to log into your computer) in the console pane. If relevant, it will ask you if you want to restore your packages for a new major version.
# install from github
devtools::install_github("AndreaCirilloAC/updateR")
# update your R version, you will need your system password
updateR::updateR()
10.2 Installing RStudio
Go to RSTUDIO.COM and download the RStudio Desktop (Open Source License) version for your operating system under the list titled Installers for Supported Platforms.
10.2.1 Installing RTools
If you are using Windows, after you install R, you should also install RTOOLS; use the “recommended” version highlighted near the top of the list. RTools is used for installing and loading some packages. You can get started without installing RTools, but if you’re having problems with installing and loading some packages, this should be the first thing you try.
RTools will require you to put it “on the PATH”. The instructions for this can seem a bit vague - the easiest way to do it is to open RStudio, run the below code in the console:
write('PATH="${RTOOLS40_HOME}\\usr\\bin;${PATH}"', file = "~/.Renviron", append = TRUE)
Once you’ve done that, restart R by clicking Session - Restart R and then run the below code in the console which should give you the path to your RTools installation:
Sys.which("make")
10.2.2 Updating RStudio
Typically, updates to RStudio won’t affect your code, instead they add in new features, like spell-check or upgrades to what RStudio can do. There’s usually very little downside to updating RStudio and it’s easy to do.
Click Help - Check for updates
If an update is available, it will prompt you to download it and you can install it as usual.
10.2.3 RStudio Settings
There are a few settings you should fix immediately after updating RStudio. Go to Global Options... under the Tools menu (⌘,), and in the General tab, uncheck the box that says Restore .RData into workspace at startup. If you keep things around in your workspace, things will get messy, and unexpected things will happen. You should always start with a clear workspace. This also means that you never want to save your workspace when you exit, so set this to Never. The only thing you want to save are your scripts.
You may also want to change the appearance of your code. Different fonts and themes can sometimes help with visual difficulties or DYSLEXIA.
Figure 10.1: RStudio General and Appearance settings
You may also want to change the settings in the Code tab. For example, Lisa prefers two spaces instead of tabs for my code and likes to be able to see the whitespace characters. But these are all a matter of personal preference.
Figure 10.2: RStudio Code settings
10.3 Packages
10.3.1 Installing Packages
This is done using INSTALL.PACKAGES(). This is like installing an app on your phone: you only have to do it once and the app will remain installed until you remove it. For instance, if you want to use PokemonGo on your phone, you install it once from the App Store or Play Store; you don’t have to re-install it each time you want to use it. Once you launch the app, it will run in the background until you close it or restart your phone. Likewise, when you install a package, the package will be available (but not loaded) every time you open up R.
# type this in the console pane
install.packages("devtools")
Install the shinyintro package on your system. This package is the main package we will use throughout this book and is not on CRAN, so you will need to get it from github using the function devtools::install_github().
# type this in the console pane
devtools::install_github("debruine/shinyintro")
If you get a message that says something like package ‘shinyintro’ successfully unpacked and MD5 sums checked, the installation was successful. If you get an error and the package wasn’t installed, check the troubleshooting section 10.5.
Never install a package from inside a script. Only do this from the console pane.
10.3.2 Updating packages
Package developers will occasionally release updates to their packages. This is typically to add in new functions to the package, or to fix or amend existing functions. Be aware that some package updates may cause your previous code to stop working. This does not tend to happen with minor updates to packages, but occasionally with major updates, you can have serious issues if the developer has made fundamental changes to how the code works. For this reason, we recommend updating all your packages once at the beginning of each academic year (or semester) - don’t do it before an assessment or deadline just in case!
To update an individual package, the easiest way is to use the install.packages() function, as this always installs the most recent version of the package.
install.packages("tidyverse")
To update multiple packages, or indeed all packages, RStudio provides helpful tools. Click Tools - Check for Package Updates. A dialogue box will appear and you can select the packages you wish to update. Be aware that if you select all packages, this may take some time and you will be unable to use R whilst the process completes.
10.4 Installing LaTeX
You can install the LaTeX typesetting system to produce PDF reports from RStudio. Without this additional installation, you will be able to produce reports in HTML but not PDF. To generate PDF reports, you will additionally need to install tinytex (R-tinytex?) and run the following code:
# run this in the console
install.packages("tinytex")
tinytex::install_tinytex()
10.5 Troubleshooting
Occasionally, you might have a few problem packages that seemingly refuse to update. For me, rlang and vctrs cause me no end of trouble. These aren’t packages that you will likely every explicitly load, but they’re required beneath the surface for R to do things like knit your Markdown files etc.
10.5.1 Non-zero exit status
If you try to update a package and get an error message that says something like Warning in install.packages : installation of package ‘vctrs’ had non-zero exit status or perhaps Error in loadNamespace(i, c(lib.loc, .libPaths()), versionCheck = vI[[i]]) : namespace 'rlang' 0.4.9 is being loaded, but >= 0.4.10 is required one solution I have found is to manually uninstall the package, restart R, and then install the package new, rather than trying to update an existing version. The installr package also has a useful function for uninstalling packages.
# Load installr
library(installr)
# Uninstall the problem package
uninstall.packages("package_name")
# Then restart R using session - restart R
# Then install the package fresh
install.packages("package")
10.5.2 Cannot open file
You may get the following error after trying to install any packages at all:
Error in install packages : Cannot open file ‘C:/…..’: Permission denied
This usually indicates a permissions problem with writing to the default library (the folder that packages are kept in). Sometimes this means that you need to install R and RStudio as administrator or run it as administrator.
One other fix may be to change the library location using the following code (check in “C:/Program Files/R” for what version you should have instead of “R-3.5.2”):
# change the library path
.libPaths(c("C:/Program Files/R/R-3.5.2/library"))
If that works and you can install packages, set this library path permanently:
The code in your .Rprofile will now run every time you start up R.
As always, if you’re having issues, please ask on Teams or come to office hours.
11 Conventions
This book will use the following conventions:
Hidden Solutions
You found it!
Informational asides.
Notes to warn you about something.
Notes about things that could cause serious errors.
Try it yourself.
# code chunks
paste("Code", "Output", 1, sep = " ")
```{r, fig.width = 2, fig.height = 2}
# code chunks with headers
hist(rnorm(100000))
```
## Markdown Example
* Inline code: `r nrow(iris)`
* *Italics*
* **Bold**
12 Symbols
Symbol | psyTeachR Term | Also Known As |
---|---|---|
() | (round) brackets | parentheses |
[] | square brackets | brackets |
{} | curly brackets | squiggly brackets |
<> | chevrons | angled brackets / guillemets |
< | less than | |
> | greater than | |
& | ampersand | “and” symbol |
# | hash | pound / octothorpe |
/ | slash | forward slash |
\ | backslash | |
- | dash | hyphen / minus |
_ | underscore | |
* | asterisk | star |
^ | caret | power symbol |
~ | tilde | twiddle / squiggle |
= | equal sign | |
== | double equal sign | |
. | full stop | period / point |
! | exclamation mark | bang / not |
? | question mark | |
’ | single quote | quote / apostrophe |
” | double quote | quote |
%>% | pipe | magrittr pipe |
| | vertical bar | pipe |
, | comma | |
; | semi-colon | |
: | colon | |
@ | “at” symbol | various hilarious regional terms |
… | glossary("ellipsis") | dots |
13 Glossary
See the PSYTEACHR GLOSSARY for more definitions of R jargon.
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